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Read this first

Thank you for purchasing the FUJIFILM Luminescent Image Analyzer LAS-

1000plus.

The FUJIFILM Luminescent Image Analyzer LAS-1000plus uses a

1,300,000-pixel cooling CCD camera developed exclusively by Fuji Film

and is a one-unit image analysis system that can be used for fluorescent

and enzyme amplification fluorescent methods, and mainly for the chemical

fluorescence method.

The "FUJIFILM Luminescent Image Analyzer LAS-1000plus Operation

Manual" describes the operation methods and usage precautions for LAS-

1000plus so that you will be able to utilize the functions to the utmost and

bring out its full performance.

Please read this manual thoroughly before operating the LAS-1000plus.

We suggest that you keep this manual, as you may need to refer to it.

* Image Reading Software "Image Reader Lite" and "Image Reader Pro"

described herein are available in both the Macintosh version and in the

Windows version.

In this manual, software operations are explained based on the Windows-

version displays, but operations using the Macintosh-version software are

basically the same as those for the Windows-version software.

NOTES
1 Reproduction of parts or all of the contents of this manual without permis-

sion is prohibited.
2 The contents of this manual are subject to change without notice.
3 This manual has been prepared with utmost care. However, if you have

any questions or find errors, ommissions, etc., please contact us.
4 We will not be liable for any effects incurred from the use of this device.

This Class A digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe:  A respecte toutes les exigences du
Règlement sur le matériel brouilleur du Canada.

Copyright Reserved

<Reprint and/or reproduction of parts or whole of this manual is prohibited.>

Copyright© 1999 by Fuji Photo Film Co., Ltd.

Apple logo is a registered trademark of Apple Computer, Inc. MacintoshTM is a registered
trademark of Apple Computer, Inc. Windows®, Windows® 95 and Windows NT ® are registered
trademarks of Microsoft Co., Ltd.
Other company names and product names mentioned in this document are the trademarks or
registered trademarks of those companies.
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This equipment cannot be taken to or used in a country
or area where power supply specifications differ from
those in the country or area where it was originally
installed.

This equipment generates, uses, and can radiate radio frequency energy and if not installed and used in accordance
with the instructions manual, may cause interference to radio communications.
It has been tested and found to comply with the limits for a Class A computing device pursuant to Subpart J of part
15 of FCC Rules, which are designed to provide reasonable protection against such interference when operated
in a commercial environment.
Operation of this equipment in a residential area is likely to cause interference in which case the user at his own
expense will be required to take whatever measures may be required to correct the interference.

United States of America

This digital apparatus does not exceed the Class A limits for radio noise emission from digital apparatus as set out
in the radio interference regulations of the Canadian Department of Communications.

“Le présent appareil numérique n’émet pas de brults radioélectriques cépassant les limites applicable aux appareils
numériques de la class A prescrites dans le Réglement sur le broulilage radioélectrique édicté par le ministére des
Communications du Canada.”

Canada
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* Make sure to have read the Operation Manual thoroughly before using
the equipment and to use the equipment properly.

* After reading the Manual, store it where it can be referred to at any time.
* Please note that the product specifications and operation manual are

subject to changes without notice.

The indicators in this Operation Manual and on the equipment are to ensure
that you use the equipment safely and properly. Various icon indicators
have been used to prevent injury to all users and property damage from
occurring. These indicators and their meanings are explained below.
Continue reading this manual after thoroughly understanding their content.

1. Cautions Prior to Use

1.1 Icon Indicators

1. Cautions Prior to Use

Indicates the possibility that a person could die or
sustain serious injury if this indicator is ignored and
the equipment is handled incorrectly.

Indicates that a person could sustain injury or there
could be physical damage if this indicator is ignored
and the equipment is handled incorrectly.

The  indicator informs the user that the contents merit warn-
ing or caution.
The specific content of the prohibition is shown within the indicator (which
on the left cautions against electric shock).

The  indicator informs the user of prohibited actions.
The specific content of the prohibition is shown within or nearby the indica-
tor (which on the left prohibits disassembly).

The  indicator informs the user of actions that must be per-
formed.
The specific content of the action is shown within the indicator (which on
the left instructs the user to unplug a power supply plug from an electrical
outlet). Make sure to do exactly as instructed.

1.2 Examples of Icon Indicators
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* In the unlikely event that smoke can be perceived, the outside of the equipment
becomes unusually hot, strange odors or noises can be perceived, etc.,  and the
equipment is used under such abnormal conditions, fire and electric shock could
result. Immediately suspend usage, turn OFF equipment power, and then unplug
the power supply plug from the electrical outlet. Confirm that smoke no longer can
be perceived and then contact your dealer to request repairs.

* In the unlikely event that water gets into the camera head and/or controller, first
turn OFF the equipment's power supply switch, unplug the power supply plug
from the electrical outlet, and then contact your dealer. Using the equipment in
this condition could result in fire and electric shock.

* In the unlikely event that a foreign object gets into the dark box, camera head and/
or controller, first turn OFF the equipment's power supply switch, unplug the
power supply plug from the electrical outlet, and then contact your dealer. Using
the equipment in this condition could result in fire and electric shock.

* In the unlikely event that the equipment is dropped and the cabinet is damaged,
turn OFF the equipment's power supply switch, unplug the power supply plug
from the electrical outlet, and then contact your dealer. Using the equipment in
this condition could result in fire and electric shock.

* Do not remove covers of the dark box, camera head and/or controller, because
inside are parts of high temperature and voltage that could result in burns or
electric shock. Contact your dealer to request internal inspections, servicing,
and repairs.

* Do not place on the dark box, camera head and/or controller vases, flowerpots,
cups, cosmetics, medical supplies, containers that have water or the like in them,
or small metal objects. If such items are spilled or fall into the equipment, fire and
electric shock could result.

* Do not use the equipment at other than the indicated power supply voltage or fire
and electric shock could result.

* Make sure to directly connect the power supply plug to a wall outlet (tripolar plug
socket) that has a ground terminal. Extension using table taps or putting many
loads on one electrical outlet could result in fire and electric shock.

* Make sure that no water gets into the camera head and/or controller and that they
do not get wet or fire and electric shock could result.

Make sure to connect
a ground wire.

Unplug the power
supply plug from the
electrical outlet.

Disassembly prohibited
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* Do not place or drop such foreign objects as metal or flammable objects into the
ventilation holes of this equipment or fire and electric shock could result.

* Make sure not to place heavy objects on the power supply cord and connection
cords, and do not let them get pinned under the equipment. Cords could be
damaged by this, and fire and electric shock could result. (If carpets, etc.,  are
laid over cords and they go unnoticed, heavy objects could end up placed on
them).

* If power supply cords are damaged (core wires are exposed or there is
breakage), contact your dealer to request replacements. Using them in this
condition could result in fire and electric shock.

* Do not place the equipment on unstable tables or on inclined surfaces or other
unstable places, as the equipment could be dropped or fall, resulting in injury.

* Do not damage, process, bend excessively, twist, pull or heat power supply
cords or they could be damaged, and fire and electric shock could result.

* Do not remodel the equipment or fire and electric shock could result.

* Do not use the equipment within or near a sink or fire and electric shock could
result.

* If thunder can be heard, do not touch the power supply plug or electric shock
could result.

Touching prohibited

Use in water-accessing
places prohibited
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* Do not place the equipment in places where hot air and dust are prevalent. Doing
so will not only deteriorate image quality but could cause fire and electric shock.

* Do not block up the equipment's ventilation holes. Doing so will cause the inside
to fill with heat, which could result in fire.
Refrain from using the equipment in the following ways.
- With the equipment face up, on its side, or upside down.
- With the equipment placed in lockers, racks, bookcases and other narrow

places with poor ventilation.
- With the equipment on surfaces covered by tablecloths or the like.

* When installing the equipment, leave at least 20cm between it and any wall. Also,
to facilitate heat radiation, leave sufficient space between the equipment and
other devices or the interior could become hot, resulting in fire.

* Do not sit on the equipment. Falling, breakage, and injury could result.

* Do not place heavy objects on the equipment. If balance is lost, falling, dropping,
and injury could result.

* Do not stare for a long time at the light that is emitted by the LED light source.
Doing so for a short time will not result in any problem, but doing so for a long time
could result impair your vision.

* Do not have the power supply cord near heating apparatuses. The cord's
covering could melt, resulting in fire and electric shock.

* When unplugging the power supply plug and connection cords from electrical
outlets, do not pull the cord itself or it could be damaged, resulting in fire and
electric shock. Make sure to grasp the plug itself when unplugging a cord.
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* Do not plug in or unplug power supply cords with wet hands or electric shock
could result.

* If the power supply plug is damaged or contact with the electrical outlet is not
secure, do not use the equipment or electric shock, short circuiting, and outbreak
of fire could result.

* When moving the equipment, make sure to first turn OFF the power supply
switch, unplug the power supply plug from the electrical outlet, and unplug any
connecting cables between devices.

* When carrying the equipment, do not subject it to shock or malfunction could
result.

* When making repairs, for safety purposes, make sure to unplug the power supply
plug from the electrical outlet or electric shock could result.

* If the equipment will not be used for a long time, for safety purposes, unplug the
power supply plug from the electrical outlet or fire could result.

* When installing the camera head to the dark box, use the dedicated screw holes
and screws, fixating the dark box in 4 places.
When installing the camera head to something other than the dedicated dark
box, do not use screws over 10mm in the fixating holes for the screws. Do not
conduct installation with methods other than those instructed herein or damage
to the equipment and malfunction could result.

!! This caution does not apply to the LAS-1000plus.

* Using dedicated cables, make secure connections to the camera head, dark box,
analyzing unit personal computer, and power supply. Imperfect connection and
connections made with other than the dedicated cables could result in incorrect
operation and malfunction. When connecting and disconnecting cables, do so
with the power OFF or incorrect operation and malfunction could result. Do not
bend cables in excess, bundle them or place heavy items on them or incorrect
operation and malfunction could result.
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* Never touch the shutter of the camera head. If the shutter becomes deformed,
correct operation will not be possible.

!! This caution does not apply to the LAS-1000plus.

* Do not install anything other than the attached lens and attached C-mount
adapter. When using a C-mount lens, use the dedicated C-mount adapter. If an
adapter other than the specified is used, malfunction could result.

!! This caution does not apply to the LAS-1000plus.

* Do not connect anything other than the dedicated light source to the dark box's
internal connectors.

* Do not throw the camera head and/or camera controller into fire.
Explosion could result in injury or burns.

* Do not unnecessarily turn the equipment's power switch ON/OFF repeatedly or
malfunction could result.

* Do not leave exposure specimens in the dark box or sample tray or malfunc-
tion could result.

1. Cautions Prior to Use
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2. Usage Cautions

2.1 Place of Installation So that we may have you use the equipment normally and safely, install it
in places such as the following.

* Places not subjected to direct sunlight or other strong light.
If necessary, shield out light using curtains, blinds, and the like. The
presence of strong light can cause fogging*.

* Fogging: The phenomenon in which light leakage and other unintended light accumu-
late on recorded images.

* Places that can support the weight of the equipment, are subjected to
little vibration, and are level and stable.

* Places with good ventilation and little dust.

Note :
In dusty environments, dirt and/or unevenness may appear on image.
Moreover, cooling capacity can deteriorate.

* Places in which temperature does not suddenly change.
Sudden heating of a cold room or moving the equipment from a low- to
high-temperature place can cause water droplets (dew condensation) to
form inside the equipment, resulting in incorrect shutter operation, and
quality deterioration, such as image blurring.

* Places with no nearby water faucets, hot-water heaters, warmers,
coolers, heaters, stoves, etc. (high-temperature, high-humidity or low-
temperature, low-humidity places).

* Recommended usage environment*
Temperature: +18oC ~ +28oC
Humidity: 35%RH ~ 70%RH (with no dew condensation)

* To elicit satisfactory performance, we recommend using the equipment in the
environments described above.

Using the equipment under high temperatures causes cleaning system
startup to take longer and is a cause of errors.

* Avoid having objects nearby that emit strong magnetism (motors,
transformers, televisions, speakers, magnets, etc.), or incorrect opera-
tion could result.

* When installing this equipment, leave at least 20cm between it and any
walls. Also, to facilitate heat radiation, leave sufficient distance from
other devices. Otherwise, heat could built up inside, resulting in fire.

* Do not place objects on top of the equipment or errors and malfunction
could result.

2. Usage Cautions
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2.2 Power Supply * Conduct in the power supply under stable voltage and use it for  the
dedicated power supply.

* Make sure to directly connect the power supply plug to a wall outlet
(tripolar plug socket) that has a ground terminal. Extension using table
taps or putting many loads on one electrical outlet could result in fire and
electric shock.

* Do not wire from the same power supply used by air conditioners,
centrifuges, and other large devices or incorrect operation could result.

* Conduct the following inspections periodically to make sure of the
following:

- The power supply plug is inserted firmly in the electrical outlet.

- The power supply plug and cord do not become abnormally hot.

- The power supply cord does not have cracks or scratches in it.
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2.3 Operational and Maintenance
Cautions

 Operational Cautions * Do not perform any operations that are not described in the Operation
Manual.

* Turn the power supply for the controller OFF after first quitting the
reading software. Turning the power OFF without first quitting the
reading software could damage the cleaning system.

* Use the following procedure when unplugging the power supply plug
from the electrical outlet.

(1) Quit the reading software.

(2) Press the power supply switch OFF.

(3) Unplug the power supply plug.

2. Usage Cautions
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3. LED Light Source

LED Used Blue-, Green-, Red- and White-LEDs are used in the LAS-1000plus.
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Part

2
LAS-1000plus System Configuration
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1. LAS-1000plus System
Hardware Configuration

Fig. 2.1  Hardware Configuration (Example: Macintosh version)

Camera head

Intelligent dark box II
(IDXII)

Camera controller

MO drive Analyzing unit LBP

1. LAS-1000plus System Hardware Configuration
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2. Specifications

2.1 Performance Characteristics (1) CCD: 1,300,000-pixel cooling CCD camera
Effective pixels; 1,384(H) X 922(V)-pixels
(On-chip micro lens is used.)

(2) Cooling temperature: -60o Celsius from ambient temperature Fixed
at -25oC when the Image Reader LAS-1000
Lite is used.

(3) Reading noise: 20e- (rms) typ.

(4) Dark current noise: 0.01e-/pix .sec or less

(5) Number of gradations: At time of image recording:
     14 bits (16 bits after shading correction)
At time of focalization:
     8 bits

(6) Exposure time: 1/100sec - 3600sec; bulb exposure

(7) Focusing: Approx. 4 frames/sec

(8) Shading correction: Software system

(9) Lens distorsion correction: Software system

(10) Angle of field: 12cmx8cm - 25cmx25cm
(when the URF20L lens is used.)

(11) Dynamic range: 3.7 orders

(12) Maximum image capacity: 2.5MB (full-size images) / 1 image

2.2 External Dimensions
and Weight

Unit

Camera head

Camera controller

Dark boxIm
ag

e 
in

pu
t u

ni
t

Dimensions (Width X Depth X Height)

200mm X 170mm X  170mm

120mm X  370mm X  330mm

430mm X  430mm X  750mm

Weight

3.8 kg

6.5 kg

33.4 kg *

2.  Specifications

* Tray and lens are not included. (Lens weight : 0.8 kg)
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2.4 Physical Environment (1) Operating Environment
* Temperature: 15 to 30oC(   T<10oC/h)
* Humidity: 35 to 70% RH (no dew condensation)

(2) Non-operating Environment
* Temperature: -10 to 60oC
* Humidity: 20 to 90% RH (no dew condensation)

(3) Transit/Storage Environment
* Temperature:  -25 to 70oC
* Humidity:  5 to 95% RH (no dew condensation)

2.3 Power Requirements (1) Input voltage: 100-120 VAC+10% / 200-240 VAC -10% +5%
(2) Phase: Single (with 3P grounding pole)
(3) Power frequency: 50/60Hz
(4) Power consumption: 0.3kVA

2.  Specifications
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Software Installation



18

2001. Oct.   Version 2.01. Introduction / 2. Software Installation and Uninstallation

1. Introduction

2. Software Installation
and Uninstallation

2.1 Software Installation
(for Windows)

1 Insert the installer CD-ROM (Image Reader LAS-1000 for Windows and
Macintosh) into the CD-ROM drive.

2  Activate   located in the Control Panel and click  .

Image Reader LAS-1000 Lite is software exclusively for the LAS-1000plus
system.
Image Reader LAS-1000 Pro is available for both the LAS-1000C and LAS-
1000 systems.
(Image Reader LAS-1000 Lite cannot be used for these systems.)

Double-click this icon.

Click here.
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3 A dialog as the one shown below will appear. Click the 
button.

4 Carefully read the messages, warnings, etc. appearing in the Welcome
dialog below and click the  button to proceed to the Software
License Agreement dialog.

5 Carefully read details of the agreement appearing in the Software
License Agreement dialog below. If you agree, press the 
button to proceed to the Information dialog.

2. Software Installation and Uninstallation
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6 In the Information dialog shown below, click the  button to
proceed to the User Information dialog.

7 In the User Information dialog shown below, enter your name and
company name and then click the  button to proceed to the
Choose Destination Location dialog.

8 To change the default destination for software installation, click the
 button in the Choose Destination Location dialog shown

below and proceed to the Choose Folder dialog.
Proceed to step 10 if the default destination need not be changed.
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9 In the Choose Folder dialog shown below, specify destination for
installation of the Image Reader LAS-1000 software, and press the

 button. The display will then return to the Choose Destination
Location dialog.

10 In the Choose Destination Location dialog shown below, click the
 button to proceed to the Setup Type dialog.

2. Software Installation and Uninstallation

User's Tips:
The default folder setting is: C:¥Prog...¥Fujifilm¥Image Reader

11 In the Setup Type dialog shown below, select type of the intelligent dark
box (IDX) actually connected to the system. Select the LAS-1000plus
LAS-1000 -> If the IDX is connected, only Image Reader Pro will

be installed.
LAS-1000plus -> If the IDXII is connected, both Image Reader Pro

and Image Reader Lite will be installed.
LAS-1000mini -> If the IDXII is connected, both Image Reader Pro

and Image Reader Lite for LAS-1000mini will be
installed.
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12 In the Select Program folder dialog shown below, enter program folder
name for registering the startup menu and click the  button to
proceed to the Start Copying Files dialog.

13 In the Start Copying Files dialog shown below, confirm the User
Information, Setup Type and the Destination Directory (destination for
installation of this software), and then click the  button.
Software installation will begin.

2. Software Installation and Uninstallation
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14 When software installation is completed, the following Setup Complete
dialog will appear. Select items as necessary or click the 
button to complete installation.

2. Software Installation and Uninstallation
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2.2 Software Uninstallation 1 Open the Control Panel and double-click .

2 Select "Image Reader LAS-1000" in the dialog shown below and click
the  button.
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3 The Confirm File Deletion dialog will appear. Click  if you wish
to uninstall the software. Software uninstallation will begin.

4 A dialog that indicates the progression of software uninstallation ("Re-
move Programs from Your Computer" dialog) will appear. When soft-
ware uninstallation is completed, the  button will change to be
active. Click  to complete uninstallation.
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2.3 Software Installation
(for the Macintosh)

1 Insert the installer CD-ROM (Image Reader LAS-1000 for Windows and
Macintosh) into the CD-ROM drive.

2 If the intelligent dark box connected is the IDX, copy the FUJIFILM LAS-
1000 folder onto the Macintosh HD.
If it is the IDXII, copy the FUJIFILM LAS-1000plus folder onto the same
HD.

FUJIFILM LAS-1000 folder -> Contains only Image Reader Pro.
FUJIFILM LAS-1000plus folder -> Contains both Image Reader Pro

and Image Reader Lite.
FUJIFILM LAS-1000mini folder -> Contains both image Reader Pro

and Image Reader Lite for LAS-
1000mini.

Software installation will thus be completed.

mini
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3. MATROX Meteor II

3.1 Video Board Driver Installation

User's Tips:
The Image Reading software will not be activated unless the  Meteor II driver
is installed.

1 Insert the installer CD-ROM (Image Reader LAS-1000 for Windows and
Macintosh) into the CD-ROM drive.

2 Activate  located in the Control Panel and click .

Double-click this icon.

Click here.
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3 A dialog as the one shown below will appear. Click the 
button.

4 Select "install.bat" contained in the MATROX METEOR2 folder.

5 Confirm the Run Installation Program dialog and then click the
 button.
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7 The destination for installation of the METEOR II driver can be changed
in the Product directory dialog shown below.

To change the destination for installation of the METEOR II driver, click
the  button to proceed to the Product directory dialog.

6 Confirm the Destination Folder in the Matrox Imaging Products dialog
shown below.
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8 In the Matrox Imaging Driver dialog shown below, click "Meteor-II" to
check it, and then the  button.

9 In the Meteor2 non-paged buffers dialog shown below, click "3.0Mb" to
check it, and then the  button.

3. MATROX Meteor II
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11 If  is clicked in the Matrox Imaging Products redistribution
dialog, driver installation will begin.

10 In the Meteor2 setup dialog shown below, click "No" to check it, and
then the  button.
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12 When driver installation is completed, the following Matrox Imaging
Products - Redistribution setup dialog will appear.

13 Driver installation will thus be completed. When using the MeteorII
functions, click the  button to complete installation, and then
rebooot the Computer.

3. MATROX Meteor II
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Part

4
Operations I
(Image Reader LAS-1000 Lite)
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Explained in this section are operation methods, using the image reading
software "Image Reader LAS-1000 Lite," for detecting samples that emit
chemiluminescence, fluorescence and enzyme amplification fluorescence, and
stained gels and film samples.

1 Turn ON the power supply.

Power supply for the camera controller and peripheral devices of the
computer. Then, turn ON the power supply for the computer itself.

Note
Be sure to turn ON the power to the camera controller first, otherwise the
camera controller  sometimes cannot be recognized.

User's Tip:
After a few minutes, the Image Input Unit will be able to read. With the power
ON, the camera's cooling temperature will automatically be cooled to
–20oC.
Cooling temperature will then be cooled further to –25oC when the Image
Reader has been activated.

POWER lamp

EXP. lamp

ERROR lamp

POWER

EXP.

ERROR

Power switch

Fig. 4.1  Turning camera controller power ON

1. Startup

* Image Reader LAS-1000 Lite can be operated only in the IDXII-con-
nected LAS-1000plus system.
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2 Activate the image reading software, "Image Reader LAS-
1000 Lite."

On the computer, activate the image reading software, "Image Reader
LAS-1000 Lite," . After the opening dialog has been displayed, this
software will be activated.

Fig. 4.2 Opening dialog

User's Tip:
1. A correction filter can be created when the software is activated. In this

case, wait for a while.
2. Software operation will be possible when Cooling is READY on the display.

1. Startup

Fig. 4.3 Screen display right after software has been activated
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(1) Menu display
Save... Saves images. (See step 9-6.)

Page Setup... Sets up page layout.

Print... Prints images to the LBP.

(See step 9-3.)

Print PG Prints images to the Pictrography.

(See step 9-4.)

Exit Exits from this software.

2. Window Configuration

2. Window Configuration

Fig.4.4 Window configuration (right after the software has been activated)

(1)

(2)

(3)

(4)

(5)

The window right after the software has been activated will be as shown
below.
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Nega Displays images on negative.

(See step 9-1.)

Posi Displays images on positive.

(See step 9-1.)

Range Scope Adjusts image gradations.

(See step 9-2.)

About.... Displays the opening dialog.

Option Setting... Allows selection of light source and filter type after
selecting the Option mode for a photography mode.

Remember to complete the tasks shown below before selecting the type of
filter.

For Windows user:
Create a text file named <FILTER.TXT> in the Image Reader LAS-1000
Folder. (in the same hierarchy as the readme.txt). The extension <.txt> will
be automatically in cluded when the WordPad is used.
The file name <FILTER> may be either uppercase or lowercase letters. In
the text file, include a name of filter (user definable) installed in the Dark
Box II as Option filter in the "harf width" alphanumeric characters.

For Macintosh user:
Create a text file named <FILTER.TXT> in the Image Reader LAS-1000
Folder ( in the same hierarchy as the readme.txt) with the Simple Text or
other appropriate text editor. Remember to attach the extension <.txt>.
The file name <FILTER> may be either uppercase or lowercase letters. In
the text file, include a name of filter (user definable) installed in the Dark
Box II as Option filtter in the "harf width" alphanumeric characters.

Setting method of Option Setting
Light......

Select a light source to be used as
Option mode from the pull-down
menu.

EPI......Select this option to use the vertical
illumination incorporated in the
IDXII.

Ext......Select this option to use any external
(transmitted) light source.

EPI+Ext......Select this option to use the
vertical light source and any
external light source concurrently.
Filter......Select a name of filter installed as

Option filter.

2. Window Configuration
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(2) Sets the exposure time.

(4) Displays that CCD cooling temperature is good for exposure.
Exposure will be disabled when "WAIT" is displayed. Wait until "READY"
appears.

(3) Selects sensitivity. When "High" is selected, binning processing will be
performed allowing exposure sensitivity to be higher than for normal
exposure. (In the Digitize mode, selection of sensitivityis set disabled.)

2. Window Configuration

The optimum exposure time will be automatically set

by the software.

The exposure time can be set as desired (up to 60

minutes) from the pull-down menu.
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(5) Displays in green the exposure mode selected and the number of the
stage on which the tray has been set.

Indicates that exposure of fluorescence samples is selected.
(Displayed in blue.)

Indicates that exposure of chemiluminescence samples is selected.
(Displayed in black.)

Indicates that exposure of stained gels/film samples using
the incident light method (EPI) is selected.
(Gradations appearing on the top)

Indicates that exposure of stained gels/film samples using
the transmitted light method (DIA) is selected.
(Gradations appearing at the bottom)

Indicates that exposure of fluorescence samples using the
optional filter is selected.
(Displayed in blue.)

2. Window Configuration
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Indicates selection of exposure of fluorescent samples
using an option filter and external (transmitted) light source.
(The bottom should be shownin pu ple gradations.)

Indicates selection of exposure of fluorescent samples
using an option filter, vertical illumination and external light
source. (The sould be shown in blue and the bottom in
purple gradations.)

2. Window Configuration
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Option Digitizing Fluorescence
Chemi-
Iuminescence

3. Exposing Chemilumi-
nescence Samples

1 Make sure that the entire system has been activated nor-
mally.

2 Open the IDXII door and attach the upper and lower handles
for exposure of chemiluminescence samples.

3. Exposing Chemiluminescence Samples

Upper handle

Lower handle
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3 Select the tray position in accordance with the size of the
sample.

Angle of field

Inside the intelligent dark box, there are 7 stages of tray rails, making it
possible to change the height of the sample tray depending on the
position it is inserted in.

Tray rail

Door

Fig. 4.5  7 stages of the tray position

This allows the size of the field of view (angle of field) to be changed so
that the sample can be read on screen at the optimal size.
Size of the field of view, which depends on the height, corresponds to
the 7 stages as follows.

Tray rail

1

2

3

4

5

6

7

Shown on the next page are actual sample sizes, 1 ~ 5, when using the
high-sensitivity lens.

Camera head

High-sensitivity lens

7 X 11 cm

9 X 14 cm

12 X 18 cm

14 X 21 cm

17 X 25 cm

20 X 25 cm

25 X 25 cm

3. Exposing Chemiluminescence Samples

Tray position display
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3. Exposing Chemiluminescence Samples
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5 Adjust the focus.

Click  located at the bottom of the window.
The focusing screen shown below will appear. While observing the
image, adjust the focus using the "Brightness" and "Adjust" (focusing)
buttons. Once the optimum image has been obtained, click the 
button. This will return the display to the previous screen.

User's Tip:
1. If the mouse cursor is placed inside the image, the cursor shape will

change to . If the cursor is clicked while  is appearing, the image
will be magnified 4 times as large as the original size. (If the cursor is
clicked again, the image will be displayed in its original size.) "Bright-
ness" and/or "Adjust" (focusing) processing are possible on the magni-
fied image.

2. The focus position undergone fine adjustment with "Adjust" (focusing)
processing will be recorded using the  button, which can be
used for next exposure.

4 Place the sample on the sample tray and set it on the tray
rails selected. Shut the door.

User's Tips :
The trays are marked with angle of field for each tray position.

Fine-adjustment button Click this button lastly.

3. Exposing Chemiluminescence Samples
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6 Set the exposure time.

If "AUTO" is selected, appropriate exposure time of the sample will be
set automatically by the software.

To manually set the exposure time, place the mouse cursor in the input
column and enter the value (1/100 sec. to 60 min.) directly from the
keyboard or set it arbitrarily using the pull-down menu.

3. Exposing Chemiluminescence Samples
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7 High-sensitivity mode can be selected. (Binning processing )

Click  at the left of "High" to have it selected , as required.

User's Tip:
1. High-sensitivity mode is the binning processing function combined with

the image processing function.
2. Binning processing digitizes image data after subjecting it to analog

processing taking 4 pixels (2 X 2 pixels) as 1 pixel. Though binning
processing decreases overall image resolution, it increases sensitivity.

3. In high-sensitivity mode, coarse image due to decreased resolution will
be corrected by the software.

8 Start exposure.

Click the  button. Exposure progression display as shown
below will appear to start exposure.

3. Exposing Chemiluminescence Samples

Click to discontinue exposure for any reason.
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9 Processing after exposure has been completed.

After the completion of exposure, a display as the one shown below will
appear.
The following 5 kinds of operations are possible on the display.

(1) Selecting negative or positive See step 9-1.
(2) Adjusting gradations using the Range Scope function See step 9-2.
(3) Printing images to the LBP See step 9-3.
(4) Printing images to the Pictrography See step 9-4.
(5) Printing images to the video printer See step 9-5.

(no button on the display)
(6) Saving images See step 9-6.
(7) Returning to the top screen after quitting See step 9-7.

(1), (2)

(4) (3) (6) (7)

3. Exposing Chemiluminescence Samples
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9-1 Selecting negative or positive

Select "Nega" or "Posi" from the Image menu.

3. Exposing Chemiluminescence Samples
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9-2 Adjusting gradations using the Range Scope function

User's Tip:
Range Scope is the function for enhancing gradations on an image file by
arbitrarily selecting gradation areas that should be displayed. This function
can be used effectively when gradation levels are concentrated in narrow
ranges.

Note :
This function changes only gradations viewed on the monitor and does not
change pixel intensity of image data.

Gradation adjustment : Gradations can be adjusted using either of the
following 2 methods.

(1) After adjusting the upper-limit and lower-limit bars (blue/red) in the
Rangescope box by dragging the mouse, click the button.

(2) After gradation adjustments by clicking the adjustment dial  or by
entering values directly from the keyboard with the cursor placed in
the input column, click the  button.

Select Range Scope
from the Image menu to display the Range
Scope dialog.Overview box

Displays the whole image.

Scopeview box
Displays images around the viewscope
frame in the Overview box.

3. Exposing Chemiluminescence Samples

Rangescope box
Displays the intensity distribution in
the image areas of the Overview box
or the Scopeview box.

Applies gradation adjustments.
When the video printer is con-
nected, if the Apply button is
pressed, the gradation display
applied will be transmitted to the
video printer.

Closes the dialog.
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9-3 Printing images to the LBP

If  is clicked, the Adjust dialog shown below will appear. Set the
width and height reduction ratios and then click .

The Print dialog shown below will appear. Set items as necessary and
. Printing will begin.

3. Exposing Chemiluminescence Samples
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9-4 Printing images to the Pictrography

If   is clicked, the Adjust dialog shown below will appear. Set the
width and height reduction ratios and then click . Printing will
begin.

9-5 Printing to the video printer
(When optional video printer is connected)

If the video printer's print button is clicked, images will be printed from
the video printer.
* Print output to the video printer does not reflect preset corrections.

Gradations on an evenly enhanced image can look unnatural. In this case,
adjust gradations using the Range Scope function.

9-6 Saving images

If  is clicked, the File Save dialog shown below will appear.

(1) (2) (3)

File names will be given automatically. Automatically given file names
can be changed as desired.
Elements of a file name in the sample above are as follows.
(1) F : Fluorescence (Fluorescence sample)

C: Chemiluminescence (Chemiluminescence sample)
D: Digitizing (Stained gel/film sample)

(2) Date of exposure
(3) Image number (serial number of the day)

3. Exposing Chemiluminescence Samples
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16bit TIFF file ...Stores the file in the format of 16-bit tiff file.
8bit TIFF file ...Stores the file in the format of 8-bit tiff file.
For the 8bit file, an area selected by the adjust bar in the Range scope
will be in 8-bit format.

To save a file, specify destination and click .

User's Tip:
A file that have the extension of ".img" is the image file. The image
information file (.inf) will also be created at the same time as when the image
file is created.
Deleting an ".inf" file from the hard disk will cause problems with the ".img" file
created as a pair.

9-7 Returning to the top screen after quitting

If  is clicked, the display will return to the top screen.
* Changing the tray position and/or exposure mode on the display after

completion of exposure will not update such information. Information
updating is possible only when the display has returned to the top screen
by clicking  Complete.

10 Quitting software

Select "Exit" from the File menu on the top screen. This will quit soft-
ware.

File types can be selected from the pull-down menu shown below.

3. Exposing Chemiluminescence Samples
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Option Digitizing Chemi-
Iuminescence Fluorescence

4. Exposing Fluorescent
Samples or Enzyme
Amplification Fluores-
cent Samples
(Fluorescence)

1 Make sure that the entire system has been activated nor-
mally.

2 Open the IDXII door and attach the upper and lower handles
for exposure of fluorescent samples.

Upper handle

Lower handle

4. Exposing Fluorescent Samples or Enzyme Amplification Fluorescent Samples (Fluorescence)
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This allows the size of the field of view (angle of field) to be changed so
that the sample can be read on screen at the optimal size.
Size of the field of view, which depends on the height, corresponds to
the 7 stages as follows.

3 Select the tray position in accordance with the size of the
sample.

Angle of field

Inside the intelligent dark box, there are 7 stages of tray rails, making it
possible to change the height of the sample tray depending on the
position it is inserted in.

Tray rail

Door

Fig. 4.7  7 stages of the tray position

Tray rail

1

2

3

4

5

6

7

Shown on the next page are actual sample sizes, 1 ~ 5, when using the
high-sensitivity lens.

Camera head

High-sensitivity lens

7 X 11 cm

9 X 14 cm

12 X 18 cm

14 X 21 cm

17 X 25 cm

20 X 25 cm

25 X25 cm

Tray position display

4. Exposing Fluorescent Samples or Enzyme Amplification Fluorescent Samples (Fluorescence)
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4. Exposing Fluorescent Samples or Enzyme Amplification Fluorescent Samples (Fluorescence)
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5 Adjust the focus.

Click  located at the bottom of the window.
The focusing screen shown below will appear. While observing the
image, adjust the focus using the "Brightness" and "Adjust" (focusing)
buttons. Once the optimum image has been obtained, click the 
button. This will return the display to the previous screen.

User's Tip:
1. If the mouse cursor is placed inside the image, the cursor shape will

change to . If the cursor is clicked while  is appearing, the image
will be magnified 4 times as large as the original size. (If the cursor is
clicked again, the image will be displayed in its original size.) "Bright-
ness" and/or "Adjust" (focusing) processing are possible on the magni-
fied image.

2. The focus position undergone fine adjustment with "Adjust" (focusing)
processing will be recorded using the  button, which can be
used for next exposure.

4 Place the sample on the sample tray and set it on the tray
rails selected. Shut the door.

Fine-adjustment button Click this button lastly.

4. Exposing Fluorescent Samples or Enzyme Amplification Fluorescent Samples (Fluorescence)
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6 Set the exposure time.

If "AUTO" is selected, appropriate exposure time of the sample will be
set automatically by the software.

To manually set the exposure time, place the mouse cursor in the input
column and enter the value (1/100 sec. to 60 min.) directly from the
keyboard or set it as desired using the pull-down menu.

4. Exposing Fluorescent Samples or Enzyme Amplification Fluorescent Samples (Fluorescence)
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7 High-sensitivity mode can be selected. (Binning processing )

Click  at the left of "High" to have it selected , as required.

User's Tip:
1. High-sensitivity mode is the binning processing function combined with

the image processing function.
2. Binning processing digitizes image data after subjecting it to analog

processing taking 4 pixels (2 X 2 pixels) as 1 pixel. Though binning
processing decreases overall image resolution, it increases sensitivity.

3. In high-sensitivity mode, coarse image due to decreased resolution will
be corrected by the software.

8 Start exposure.

Click the  button. Exposure progression display as shown
below will appear to start exposure.

Click to discontinue exposure for any reason.

4. Exposing Fluorescent Samples or Enzyme Amplification Fluorescent Samples (Fluorescence)
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(1), (2)

(4) (3) (6) (7)

9 Processing after exposure has been completed.

After the completion of exposure, a display as the one shown below will
appear.
The following 5 kinds of operations are possible on the display.

(1) Selecting negative or positive See step 9-1.
(2) Adjusting gradations using the Range Scope function See step 9-2.
(3) Printing images to the LBP See step 9-3.
(4) Printing images to the Pictrography See step 9-4.
(5) Printing images to the video printer See step 9-5.

(no button on the display)
(6) Saving images See step 9-6.
(7) Returning to the top screen after quitting See step 9-7.

4. Exposing Fluorescent Samples or Enzyme Amplification Fluorescent Samples (Fluorescence)
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9-1 Selecting negative or positive

Select "Nega" or "Posi" from the Image menu.

4. Exposing Fluorescent Samples or Enzyme Amplification Fluorescent Samples (Fluorescence)
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9-2 Adjusting gradations using the Range Scope function

User's Tip:
Range Scope is the function for enhancing gradations on an image file by
arbitrarily selecting gradation areas that should be displayed. This function
can be used effectively when gradation levels are concentrated in narrow
ranges.

Note :
This function changes only gradations viewed on the monitor and does not
change pixel intensity of image data.

Gradation adjustment : Gradations can be adjusted using either of the
following 2 methods.

(1) After adjusting the upper-limit and lower-limit bars (blue/red) in the
Rangescope box by dragging the mouse, click the button.

(2) After gradation adjustments by clicking the adjustment dial  or by
entering values directly from the keyboard with the cursor placed in
the input column, click the  button.

Overview box
Displays the whole image.

Scopeview box
Displays images around the viewscope
frame in the Overview box.

Rangescope box
Displays the intensity distribution in
the image areas of the Overview box
or the Scopeview box.

Applies gradation adjustments.
When the video printer is con-
nected, if the Apply button is
pressed, the gradation display
applied will be transmitted to the
video printer.

Closes the dialog.

4. Exposing Fluorescent Samples or Enzyme Amplification Fluorescent Samples (Fluorescence)

Select Range Scope
From the Image menu to display the Range Scope dialog.
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9-3 Printing images to the LBP

If  is clicked, the Adjust dialog shown below will appear. Set the
width and height reduction ratios and then click .

The Print dialog shown below will appear. Set items as necessary and
. Printing will begin.

4. Exposing Fluorescent Samples or Enzyme Amplification Fluorescent Samples (Fluorescence)
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9-5 Printing to the video printer
(When optional video printer is connected)

If the video printer's print button is clicked, images will be printed from
the video printer.
* Print output to the video printer does not reflect preset corrections. Gradations on an evenly

enhanced image can look unnatural. In this case, adjust gradations using the Range Scope
function.

9-6 Saving images

If  is clicked, the File Save dialog shown below will appear.

9-4 Printing images to the Pictrography

If   is clicked, the Adjust dialog shown below will appear. Set the
width and height reduction ratios and then click . Printing will
begin.

(1) (2) (3)

File names will be given automatically. Automatically given file names
can be changed as desired.
Elements of a file name in the sample above are as follows.
(1) F : Fluorescence (Fluorescence sample)

C: Chemiluminescence (Chemiluminescence sample)
D: Digitizing (Stained gel/film sample)

(2) Date of exposure
(3) Image number (serial number of the day)

4. Exposing Fluorescent Samples or Enzyme Amplification Fluorescent Samples (Fluorescence)
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16bit TIFF file ...Stores the file in the format of 16-bit tiff file.
8bit TIFF file ...Stores the file in the format of 8-bit tiff file.
For the 8bit file, an area selected by the adjust bar in the Range scope
will be in 8-bit format.

To save a file, specify destination and click .

User's Tip:
A file that have the extension of ".img" is the image file. The image
information file (.inf) will also be created at the same time as when the image
file is created.
Deleting an ".inf" file from the hard disk will cause problems with the ".img" file
created as a pair.

9-7 Returning to the top screen after quitting

If  is clicked, the display will return to the top screen.

10 Quitting software

Select "Exit" from the File menu on the top screen. This will quit soft-
ware.

File types can be selected from the pull-down menu shown below.

4. Exposing Fluorescent Samples or Enzyme Amplification Fluorescent Samples (Fluorescence)
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1 Make sure that the entire system has been activated nor-
mally.

2 Open the IDXII door and attach the upper and lower handles
for exposure of stained gel or film samples (Digitizing).

Note :
Attach the handles and correctly set the Transmitted Light (EPI) / Transpar-
ent Light (DIA) selector switch. Switching the selection will turn the upper
and lower light sources ON / OFF alternately.

Transmitted light method :

Option Digitizing Chemi-
Iuminescence Fluorescence

EPI

DIA

Option Digitizing Chemi-
Iuminescence Fluorescence

EPI

DIA

Transparent light method :

5. Exposing Stained Gel
or Film Samples

Upper handle

Lower handle

5. Exposing Stained Gel or Film Samples

Upper handle

Lower handle
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This allows the size of the field of view (angle of field) to be changed so
that the sample can be read on screen at the optimal size.
Size of the field of view, which depends on the height, corresponds to
the 7 stages as follows.

3 Select the tray position in accordance with the size of the
sample.

Angle of field

Inside the intelligent dark box, there are 7 stages of tray rails, making it
possible to change the height of the sample tray depending on the
position it is inserted in.

Tray rail

Door

Fig. 4.9  7 stages of the tray position

Tray rail

1

2

3

4

5

6

7

Shown on the next page are actual sample sizes, 1 ~ 5, when using the
high-sensitivity lens.

Camera head

High-sensitivity lens

7 X 11 cm

9 X 14 cm

12 X 18 cm

14 X 21 cm

17 X 25 cm

20 X 25 cm

25 X 25 cm

Tray position display

5. Exposing Stained Gel or Film Samples
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5. Exposing Stained Gel or Film Samples
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DIA

5 Adjust the focus.

Click  located at the bottom of the window.
The focusing screen shown below will appear. While observing the
image, adjust the focus using the "Brightness" and "Adjust" (focusing)
buttons. Once the optimum image has been obtained, click the 
button. This will return the display to the previous screen.

User's Tip:
1. If the mouse cursor is placed inside the image, the cursor shape will

change to . If the cursor is clicked while  is appearing, the image
will be magnified 4 times as large as the original size. (If the cursor is
clicked again, the image will be displayed in its original size.) "Bright-
ness" and/or "Adjust" (focusing) processing are possible on the magni-
fied image.

2. The focus position undergone fine adjustment with "Adjust" (focusing)
processing will be recorded using the  button, which can be
used for next exposure.

4 Place the sample on the sample tray and set it on the tray
rails selected. Shut the door.

Fine-adjustment button Click this button lastly.

5. Exposing Stained Gel or Film Samples
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6 Set the exposure time.

If "AUTO" is selected, appropriate exposure time of the sample will be
set automatically by the software.

To manually set the exposure time, place the mouse cursor in the input
column and enter the value (1/100 sec. to 60 min.) directly from the
keyboard or set it as desired using the pull-down menu.



70

2001. Oct.   Version 2.0

7 High-sensitivity mode cannot be selected for exposure of
stained gel or film samples (Digitizing).

8 Start exposure.

Click the  button. Exposure progression display as shown
below will appear to start exposure.

Click to discontinue exposure for any reason.

5. Exposing Stained Gel or Film Samples

User's Tips:
In Digitizing mode, images for which pixel densities have been inverted
automatically will be displayed.
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(1), (2)

(4) (3) (6) (7)

9 Processing after exposure has been completed.

After the completion of exposure, a display as the one shown below will
appear.
The following 5 kinds of operations are possible on the display.

(1) Selecting negative or positive See step 9-1.
(2) Adjusting gradations using the Range Scope function See step 9-2.
(3) Printing images to the LBP See step 9-3.
(4) Printing images to the Pictrography See step 9-4.
(5) Printing images to the video printer See step 9-5.

(no button on the display)
(6) Saving images See step 9-6.
(7) Returning to the top screen after quitting See step 9-7.
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9-1 Selecting negative or positive

Select "Nega" or "Posi" from the Image menu.

5. Exposing Stained Gel or Film Samples
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9-2 Adjusting gradations using the Range Scope function

User's Tip:
Range Scope is the function for enhancing gradations on an image file by
arbitrarily selecting gradation areas that should be displayed. This function
can be used effectively when gradation levels are concentrated in narrow
ranges.

Note :
This function changes only gradations viewed on the monitor and does not
change pixel intensity of image data.

Gradation adjustment : Gradations can be adjusted using either of the
following 2 methods.

(1) After adjusting the upper-limit and lower-limit bars (blue/red) in the
Rangescope box by dragging the mouse, click the button.

(2) After gradation adjustments by clicking the adjustment dial  or by
entering values directly from the keyboard with the cursor placed in
the input column, click the  button.

Select Range Scope
From the Image menu to display the Range Scope dialog.

Overview box
Displays the whole image.

Scopeview box
Displays images around the viewscope
frame in the Overview box.

Rangescope box
Displays the intensity distribution in
the image areas of the Overview box
or the Scopeview box.

Applies gradation adjustments.
When the video printer is con-
nected, if the Apply button is
pressed, the gradation display
applied will be transmitted to the
video printer.

Closes the dialog.
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9-3 Printing images to the LBP

If  is clicked, the Adjust dialog shown below will appear. Set the
width and height reduction ratios and then click .

The Print dialog shown below will appear. Set items as necessary and
. Printing will begin.

5. Exposing Stained Gel or Film Samples
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9-4 Printing images to the Pictrography

If   is clicked, the Adjust dialog shown below will appear. Set the
width and height reduction ratios and then click . Printing will
begin.

9-5 Printing to the video printer
(When optional video printer is connected)

If the video printer's print button is clicked, images will be printed from
the video printer.
* Print output to the video printer does not reflect preset corrections. Gradations on an evenly

enhanced image can look unnatural. In this case, adjust gradations using the Range Scope

function.

9-6 Saving images

If  is clicked, the File Save dialog shown below will appear.

(1) (2) (3)

File names will be given automatically. Automatically given file names
can be changed as desired.
Elements of a file name in the sample above are as follows.
(1) F : Fluorescence (Fluorescence sample)

C: Chemiluminescence (Chemiluminescence sample)
D: Digitizing (Stained gel/film sample)

(2) Date of exposure
(3) Image number (serial number of the day)
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16bit TIFF file ...Stores the file in the format of 16-bit tiff file.
8bit TIFF file ...Stores the file in the format of 8-bit tiff file.
For the 8bit file, an area selected by the adjust bar in the Range scope
will be in 8-bit format.

To save a file, specify destination and click .

User's Tip:
A file that have the extension of ".img" is the image file. The image
information file (.inf) will also be created at the same time as when the image
file is created.
Deleting an ".inf" file from the hard disk will cause problems with the ".img" file
created as a pair.

9-7 Returning to the top screen after quitting

If  is clicked, the display will return to the top screen.

10 Quitting software

Select "Exit" from the File menu on the top screen. This will quit soft-
ware.

File types can be selected from the pull-down menu shown below.
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Digitizing Chemi-
Iuminescence FluorescenceOption

Digitizing Chemi-
Iuminescence FluorescenceOption

6. Exposing Fluorescent
Samples Using
Optional Filter

3 Select the light source and filter to be used from the "Option
Setting" in the Edit menu.

4 For operations hereafter, see "4. Exposing Fluorescent
Samples or Enzyme Amplification Fluorescent Samples
(Fluorescence)."

* Make sure to attach optional filter, otherwise correct images cannot be
obtained.

* Selection of exposure time in the Option mode is available only in the
MANUAL mode.

6. Exposing Fluorescent Samples Using Optional Filter

1 Make sure that the entire system has been activated nor-
mally.

2 Open the IDXII door and attach the upper and lower handles
as follows.

When preferring resolution to sensitivity : Set the aperture to 2.8.
* Amount of differences in the result of conversion from light to electricity is
16 times as large in terms of 0.85 of aperture.

When sensitivity is required : Set the aperture to 0.85.

Upper handle

Lower handle

Upper handle

Lower handle
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1 Quit the Image Reading Software, "Image Reader LAS-1000
Lite."

A dialog like that shown below will appear. Wait for a while.

2 After this software has quit, shut down the OS and then turn
the main unit power OFF. (Depending on the machine type,
the computer power will turn OFF automatically after the OS
has been shut down.

3 Turn OFF the power to the camera controller and the
computer's peripheral devices.

User's Tip:
To reboot this system, turn the power ON again after approx. 10 sec. have
passed.

7. Quitting

7. Quitting
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Part

5
Operations II
(Image Reader LAS-1000 Pro)
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1. Startup and Quitting

1.1 Startup Double-click the  icon or start from the application registered on the
startup menu.
The opening dialog will be displayed for some seconds and the software
(Focusing) will start up.

1.2 Quitting Using the File's pulldown menu, select Quitting (or use the Alt + F4 as a

shortcut ) (for Macintosh, + Q ) to quit the software.  When quitting the
software, a dialog like that shown below will appear asking whether or not
to stop the cooling process in the camera controller.  If you want to stop the
cooling process to quit the software, press , and to quit the soft-
ware with the cooling process maintained, press .

1. Startup and Quitting
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2. 4 Modes This software consists of the following 4 operation modes.

1 To switch between modes, use the pulldown menu for Operation Mode
selection or for Mode menu selection within each mode dialog.

* Focusing (focus mode)
Used for adjusting camera focus.

* Increment (consecutive exposure mode)
Used for capturing images added consecutively
at a set, fixed interval of time.

* Precision (normal exposure mode)
Used for capturing images at a set
exposure time.

* Repetition (repeating exposure mode )
Used for capturing images repeatedly
under the same exposure conditions.

2. Modes
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* To use the IIDXII in the Option mode, select the "Option Setting..."
from the File menu.

Option Setting... Allows selection of light source and filter type after
selecting the Option mode for a photography mode.

Remember to complete the tasks shown below before selecting the type of
filter.

For Windows user:
Create a text file named <FILTER.TXT> in the Image Reader LAS-1000
Folder. (in the same hierarchy as the readme.txt). The extension <.txt> will
be automatically in cluded when the WordPad is used.
The file name <FILTER> may be either uppercase or lowercase letters. In
the text file, include a name of filter (user definable) installed in the Dark
Box II as Option filter in the "harf width" alphanumeric characters.

For Macintosh user:
Create a text file named <FILTER.TXT> in the Image Reader LAS-1000
Folder ( in the same hierarchy as the readme.txt) with the Simple Text or
other appropriate text editor. Remember to attach the extension <.txt>.
The file name <FILTER> may be either uppercase or lowercase letters. In
the text file, include a name of filter (user definable) installed in the Dark
Box II as Option filtter in the "harf width" alphanumeric characters.

Setting method of Option Setting
Light......

Select a light source to be used as
Option mode from the pull-down
menu.

EPI......Select this option to use the vertical
illumination incorporated in the
IDXII.

Ext......Select this option to use any external
(transmitted) light source.

EPI+Ext......Select this option to use the
vertical light source and any
external light source concurrently.
Filter......Select a name of filter installed as

Option filter.
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3. Mode Usage Methods

3.1 Focusing Used for adjusting camera focus.
The image taken with the CCD will be displayed. Adjust the camera lens
focus while viewing it.

(5)

(2)

(1)

(4)

(3)

* For the LAS-1000plus system, the internal light will be turned ON auto-
matically.

* For the LAS-1000C and 1000 systems, open the door to utilize the
external light.

3. Mode Usage Methods

GOOD

Circumstance:
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The following adjustments are possible in Focusing.

(1) Brightness adjustment

Use this dial to adjust brightness so that the image is easy to see.

(2) Display magnification adjustment

When the Zoom function for the display ratio is OFF, the entire image
will be displayed.
To display part of an image in an enlarged state, select ON for the Zoom
function.
Adjust the portion to be displayed in an enlarged state by clicking the 4
directional buttons or dragging the rectangular frame.

(3) Focus adjustment
Adjust the focusing finely by clicking the  and  buttons.

* This function cannot be used for the LAS-1000C and 1000 systems.

3. Mode Usage Methods
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(4) Temperature adjustment
* Automatic control of temperature adjustment will begin when the power

supply for the camera controller is turned ON.

Until the temperature adjustment command is received from this soft-
ware, the camera controller will begin cooling to a target as low as -20oC
(-4UV).
The temperature adjustment function is available common to each mode.
Set the CCD cooling temperature.

Temperature setting is done as follows.

(5) Click the button.
The following temperature setting dialog will be displayed.

(A)

(B)

Set the cooling temperature and unit in this dialog.

3. Mode Usage Methods

Status display

CCD temp.

Set temp.

Temperature around
the camera head

GOOD

Circumstance:

GOOD

Circumstance:
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(B)

(A)

3. Mode Usage Methods

Select Yes and then set the temperature, from a possible 0oC (32oF) to -
35oC (-31oF).

Note :
The cooling capacity of the camera controller is 60oC (108oF) less than the
temperature shown in "Ambient temp." on the lower left of the display.

If you select NO, cooling will not occur.
Select the unit for the temperature.

ToF=1.8 X toC+32

The status display will display <READY> if CCD temperature is within
+0.5oC (+0.9oF)of the set temperature; otherwise, it will display <WAIT>.
"Circumstance." on the lower left of the display shows the temperature
around the camera head.
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3.2 Precision

3.2.1  Setting method

(8)

(10)

(11)
(12)

(14)
(15)

(1)

(2)

(3)

(5)

(7)
(6)

(4)

(9)

(13)

The following settings and adjustments are possible in this mode.

(1) Image Type
Three types of image can be selected.

(1-1) Image
When the sample will be the image type.

(1-2) Dark-Frame
Exposes the image of the dark current noise pattern with the
shutter closed. A low-noise image can be created by subtracting
the Dark-Frame from the sample image.

(1-3) Flat-Frame
Conducts exposure with no sample.
Exposes an image of uneven brightness, resulting from lens
distortion and corrects optical unevenness. An image of good
quantitativeness can be obtained by subjecting the sample image
and this Flat-Frame to operation. Used also for correction of
optical unevenness.

* The Flat-Frame data for chemiluminescent samples has been installed at the
same time with software installation. No data is thus required to be created for

chemiluminescence exposure. Data installed includes that for the high-sensitivity

lens (URF20L) and the standard lens (CF25B), respectively.

Setting method Set using the pulldown menu, as shown next.

3. Mode Usage Methods

Used for capturing images at a set exposure time.

In this mode, the user sets the desired exposure time. The camera will
caputure the image at the time specified.
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(3) Binning Pixels
After 4 pixels (2x2) undergo analog processing as 1 pixel, they are
digitized.
From this processing, resolution of the entire image will decline but
sensitivity will increase.

Setting method Select by clicking the box for Binning Pixels.

(2) Exposure Time
Exposure time can be set to be automatic from 1/100 sec. to 3600 sec.
It can be set in 8 stages from 1/100 sec. to 1 sec. and in 1-sec. incre-
ments from 2 sec. to 3600 sec.
For bulb exposure, exposure will continue until the Stop button , is
manually clicked.

Setting method Set using the pulldown menu, as shown below.

3. Mode Usage Methods

(4) Visible Frame Grab
The chemiluminescence sample usually has a mark, which is invisible
unless visible rays are applied, and is not exposed on the captured
image.
This is the function to automatically save the image (visible image)
obtained by Digitizing mode after sample exposure.
* This function cannot be used for the LAS-1000C or LAS-1000 system.

Setting method Click the box for Visible Frame Grab to select.
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(6) Iris
For the LAS-1000plus system, the lens aperture value is automatically
selected in accordance with the IDXII setting.
Select either (right) or (left) with upper handle.

When the LAS-1000 or LAS-1000C is used, following selections are
necessary.

For a high-sensitivity lens :
Select 0.85, 1, 1.4, 2, 2.8, 4, 5.6, 8, or 11.

For a standard lens :
Select 1.4, 2, 2.8, 4, 5.6, 8, 11, or 16.

Note :
The lens aperture value set here is used as a parameter when selecting
Flat-Frame Correction, (optical unevenness correction) in chemilumines-
cence but the aperture of the lens installed in the LAS-1000 or LAS-1000C
will not be automatically controlled in accordance with it.

(7) Position
The position (from step 1 to step 7) of the specimen (tray) set inside the
LAS-1000plus dark box is displayed.

When the LAS-1000 is used, set the position using the following
pulldown menu.

(5) Lens Type
The types of lens installed in the LAS-1000 are displayed.

When the LAS-1000 is used, set the lens type using the following
pulldown.

3. Mode Usage Methods

Note :
The specimen position set here is used as a parameter when selecting Flat-
Frame Correction (optical unevenness correction) in chemiluminescence
but the specimen position inside the LAS-1000 or LAS-1000C dark box will
not be automatically controlled in accordance with it.

For the LAS-1000plus system, URF20L is automatically selected.
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(8) Dark-Frame Subtraction
With this setting, the Dark-Frame image is subtracted from the specimen
image.

Setting method Click the box for Dark-Frame Subtraction to select.

Expose Now : Exposure of both the specimen and the Dark-
Frame will be done using the set exposure
conditions. The Dark-Frame image once
exposed by the Expose Now will be automati-
cally saved in the Dark-Frame folder.

Use File : A Dark-Frame that has been exposed and saved
ahead of time will be used.When Use File is
selected, the Dark-Frame suitable for the
exposure conditions is automatically selected.

Note :
When Use File has been selected, the exposure conditions of the selected
Dark-Frame (exposure time, CCD temperature, binning) and the specimen's
exposure conditions must be in accord.

User's Tips:
If there is a regular, fixed exposure time, it is convenient to take and save
ahead of time the Dark-Frame from that exposure time. If the exposure
conditions of exposure time and cooling temperature are in accord, they can
be saved as a file and reused.

(9) Spotting
Corrects spotting that occurs in the pixels of the CCD.

Setting method Click the box for Spotting to select.

Note :
Only specimen images can be the targets for spotting correction.

3. Mode Usage Methods
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(10) Flat-Frame Correction (Optical Unevenness Correction)
Set Flat-Frame Correction for the specimen image.

Setting method Click the box for Flat-Frame Correction to select.

Set the correction method using the pulldown menu, as follows.

Chemilumi : Used for exposure with chemiluminescence.
The Flat-Frame Correction data stored in the
software ahead of time from the 3 conditions
of Lens Type, Aperture, and Position will be
used.

Fluorescence : Used for the fluorescent image exposure with
blue light.

Digitize EPI : Used for incident light digitizing.
Digitize DIA : Used for transparent system digitizing.
Option : Used for fluorescent sample exposure with

optional filter.

For the LAS-1000plus, one of
Chemilumi, Fluorescence, Digitize
EPI or Digitize DIA will be automati-
cally selected.

For the LAS-1000C, only
Chemilumi. will be used.

3. Mode Usage Methods
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Setting method Select Correct File on the pulldown File menu.

The following selection dialog will be displayed, from
which you can select the image data to undergo Flat-
Frame Correction.

To apply correction of opical unevenness for any image once stored without
correction of optical unevenness, follow the step below.

Click on the Open (O), and the corrected image
should be created.

Correction of any opical unevenness is available in two modes, auto-
matic or manual.
Automatic selection......Unless the Manual button next to Flat-Frame
Correction is set active, in any selected mode, the Flat-Frame Folder is
scanned for a match in conditions, lens type, aperture, sample position
and use or no-use of bining, to find the conditions-matched flat-frame file
for proper use.
Manual selection......To use a particular file as flat-frame file, click on the
Manual button. The dialog should open, allowing selection of any
desired file for use as a flat-frame.

3. Mode Usage Methods
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(11) Distortion Correction (Only for high-sensitivity lens)
Corrects the distortion of a lens automatically by software.

Setting method Click the box for Distortion Correction to select.

User's Tips :
If the settings of the tray position and the lens aperture are incorrect, proper
correction cannot be achieved.

(12) Invert Pixels
Supposing that film density will be measured, conducts inversion
processing on the intensity of each pixel of image data.

Setting method Click the box for Invert Pixels to select.

Note :
It is good to conduct Invert Pixels processing at time of image storage.

(13) Image Data Offset
Gives an offset value for the data after processing.

Setting method Select from the pulldown menu.

(14)  File Name

(15) Comment
Set the file name and comment for the exposed image.

Setting method Input from the keyboard into the boxes for File Name

and Comment.

(Exposure is possible even if nothing is input here.)

3. Mode Usage Methods
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3.2.2 Exposure Startup Click the Start button, , to start exposure.

(1)
(2)
(3)

(6)

(7)

(4)

(5)

3. Mode Usage Methods

After the set exposure time has elapsed, an image like that shown below is
displayed.

GOOD

GOOD
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(1)
(2)
(3)
(4)

3. Mode Usage Methods

The following dialog will be displayed if any other application is used when
exposure has been completed.

The meanings of the indicators below the image are as follows.

Selected mode

Exposure time elapsed

Set exposure time

Status indicator

Data type

Dark-Frame Subtraction processing,
YES/NO
Flat-Frame Correction processing,
YES/NO
Spotting Correction, YES/NO

Invert Pixels processing, YES/NO

Temperature status

CCD temperature

Exposure conditions

(5)

GOOD
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The following adjustments can be made.

(6) Positive/Negative switchover
Perform positive/negative switchover on the image.

Setting method Click the mouse to select.

(7) Gradation adjustment using Range Scope
Range Scope is a function for enhancing gradation by selecting the
desired gradation portion of an image file that you want to display.
This function is effectively available when gradation levels and concen-
trated in the narrow range.

Note
This function changes the appearance of the gradation (only on the monitor)
and not the pixel intensity of the image data.

Click the change button, , next to Range.
The numbers next to Range signify the upper and lower limits of contrast
adjustment for the image displayed in the window at the time.

3. Mode Usage Methods

The following is an example of switching over to positive display.

GOOD
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(5)

(2)

(1)

(4)

(3)

Overview box : Displays the entire image.

Scopeview box : Displays the image near the Viewscope frame within the

overview box.

Range Scope box : Displays the intensity distribution of the image region

selected with the Overview box or Scopeview box.

Adjustment method Adjustment can be done with the following 3 methods.

(1) Adjust by using the mouse to drag the Low bar (red) and High bar (blue)
in the Range Scope box.

(2) Adjust by clicking the adjustment dials, , next to the displayed Low
and High values.

(3) Input the Low and High values directly in the appropriate columns next
to the adjustment dials .

3. Mode Usage Methods

Viewscope frame

Overview box
Scopeview box

Range Scope box
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(4) When you have finished the adjustments, click the apply
button, ,last.
Image will be redisplayed at the adjusted gradation.

h When the reset button, , is clicked, the gradation adjustment
will be cleared off.

User's Tips:
The adjusted image is displayed also on the video printer.

Following is an example of gradation adjustment done with Range
Scope.

(5) If you click the button after saving the image, the screen will
return to the exposure condition setting window in Precision.
If you click the button without saving the image, the following
dialog will be displayed.

3. Mode Usage Methods

GOOD
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3.2.3 Printing Images

3.2.4 Saving Images

Click Pictro  or  and the following Adjust dialog will be
displayed.  Set the magnification ratio for width and height and then click

.  Printing will start.

+10% adjustment is possible.

To save an image, click  in the image display window.
The following dialog will be displayed.

Fuji Image Film : Original format unique to this software. Data saved using this format can be
quantified with Image Gauge and L Process.

TIFF File : Saves data in 16-bit gray TIFF file format. However, data saved using this
format cannot be quantified with Image Gauge or L Process.

3. Mode Usage Methods

Input the file name and comment, for storage purposes, in the above window.
Select the format in which the file should be saved.

User's Tips:
An image file name is added with ".img" as the extension. When an image
file is created, a relevant image information file (".inf") will also be created
at the same time.
If an ".inf" file is deleted from the hard disk, a problem will result in its relevant
".img" file.
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3.3 Increment

3.3.1 Setting method

(1)

(2)

(3)

(5)

(7)

(8)

(10)

(9)

(12)

(14)

(15)

(6)

(4)

(11)

(13)

3. Mode Usage Methods

Used for capturing images added consecutively at a set, fixed interval.
A maximum of 16 images, including the newest one, can be stored.

Notes :
1. With the Image Reader LAS-1000 Pro, an operation that requires a large

amount of memory, during Increment or Repetition, using other soft-
ware, may cause the Image Reader LAS-1000 Pro to drop image data.

2. Shading Correction, Distortion Correction and Video Out functions
cannot be used.

The following settings and adjustments are possible in this mode.

(1) Image Type
* With Increment and Repetition, only Image can be selected for Image Type.

(2) Interval
Exposure is done at the time interval set here and images are consecu-
tively subjected to additive processing.
For Increment, the minimum exposure time interval is 10 sec.
Exposure time can be set from 10 to 3600 sec., only automatically.
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Setting method Set sec./min. using the pulldown menu, as follows, and

input the time in the numeric column.

(3) Binning Pixels
* Available in both Precision and Repetition.

After 4 pixels (2x2) undergo analog processing as 1 pixel, they are
digitized.
From this processing, resolution of the entire image will decline but
sensitivity will increase.

Setting method Select by clicking the box for Binning Pixels.

(4) Visible Frame Grab.

(5) Lens Type
The types of lens installed in the LAS-1000 are displayed.

When the LAS-1000 is used, set using the following pulldown menu, as
follows.

In the LAS-1000plus system, URF20L will be automatically selected.

3. Mode Usage Methods
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(6) Iris
* Available in both Precision and Repetition.
For the LAS-1000plus system, the lens aperture value is automatically
selected in accordance with the IDXII setting.
Select either (right) or (left) with upper handle.
Confirm the iris of the lens that has been installed in the LAS-1000 or
LAS-1000C and set the same value.

Note :
The iris of the lens installed in the LAS-1000 or LAS-1000C will not be
automatically controlled in accordance with the value set here.
For a high-sensitivity lens :

Select 0.85, 1, 1.4, 2, 2.8, 4, 5.6, 8, or 11.
For a standard lens :

Select 1.4, 2, 2.8, 4, 5.6, 8, 11, or 16.
For other lenses :

The iris setting cannot be made.

Setting method Set using the pulldown menu, as follows.

Note
The position of the specimen inside the LAS-1000 or LAS-1000C  dark box
will not be automatically controlled in accordance with the position set here.

3. Mode Usage Methods

(7) Position
* Available in both Precision and Repetition.
The position  (from step 1 to 7) of the specimen (tray) set inside the
LAS-1000plus dark box is displayed.
When the LAS-1000 or LAS-1000C  is used, set the position using the
following pulldown.

Setting method Set the position using the pulldown menu, as follows.
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(8) Dark-Frame Subtraction
In Increment, because Dark-Frame Subtraction must be done at each
set exposure time, the Dark-Frame Subtraction setting cannot be turned
OFF.

(9) Spotting
* The sequential exposure mode (Increment), exposure will be automati-
cally shut off pixel defects, and thus the Disabled (OFF) mode cannot be
used.
Sets disabled

(10) Optical Unevenness Correction (Flat-Frame Correction)
Flat-Frame Correction processing cannot be done in Increment.

(11) Lens Distorsion Correction
Cannot be used.

(12) Invert Pixels
Supposing that film density will be measured, conducts inversion
processing on the intensity of each pixel of image data.

Setting method Click the box for Invert Pixels to select.

Note :
It is good to conduct Invert Pixels processing at time of image storage.

(13) Image Data Offset
Cannot be used.

(14) File Name

(15) Comment
Sets the file name and comment for the exposed image.

Setting method Input from the keyboard into the boxes for File Name

and Comment.

(Exposure is possible even if nothing is input.)

3. Mode Usage Methods



104

2001. Oct.   Version 2.0

3.3.2 Exposure Startup Click the Start button,  , to start exposure.
An image like that shown below will be displayed and images added at
each set exposure time will be displayed.
When the targeted image has been obtained while confirming the image,
click the stop button,  , and quit exposure.

(1)
(2)

(1)

(2)

3. Mode Usage Methods

As shown below, the window will be displayed divided in sixteen, and the
newest 16 images, including the last one obtained, will be displayed in a
time series.

* The indicators below the images, except for the time elapsed ones, are the
same as in Precision.

Exposure time elapsed

Total time elapsed

No

GOOD
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Clicking the  button after saving the image will return the screen to
the Increment condition setting window.

*In the sequential exposure mode (Increment), exposure will be automati-
cally shut off when the number of saturated pixels in a given image reaches
a predetermined value.

3. Mode Usage Methods

No

GOOD
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User's Tips:
An image file name is added with ".img" as the extension. When an image
file is created, a relevant image information file (".inf") will also be created
at the same time.
If an ".inf" file is deleted from the hard disk, a problem will result in its relevant
".img" file.

3.3.3 Saving Images Click the mouse to select the image to be saved. (It will be displayed within
a red frame).
Click  in the image display window.
The following dialog will be displayed.

If you click the  button without saving the image, the following dialog
will be displayed.

3.3.4 Printing Images

3. Mode Usage Methods

* Display content is the same as for Precision and Repetition.

Printing images is not possible.
Save the images and then output using external software.
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(1)

(2)

(3)

(5)

(7)

(8)

(10)

(9)

(12)

(14)

(15)

(6)

(4)

(11)

(13)

3.4 Repetition

3.4.1 Seeing method

3. Mode Usage Methods

Used for capturing images not repeatedly under the same exposure condi-
tions.
A maximum of 16 images, including the newest one, can be stored.

Notes :
1. Image data may drop out if heavy-load processing, such as file transfer via

the network, is done in consecutive exposure mode or repeating exposure
mode.
Please refrain from using the network while the system is in consecutive
exposure mode or repeating exposure mode.

2. Shading Correction, Distortion Correction and Video Out functions
cannot be used.

The following settings and adjustments are possible in this mode.

(1) Image Type
* In Increment and Repetition, only Image can be selected for Image Type.
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(2) Interval
Exposure will be done at the time interval set here and images are
captured.
For Repetition, the minimum exposure time is 10 sec.
Exposure time can be set, automatically only, from 10 sec. to 3600 sec.

Setting method Set sec./min. using the pulldown menu, as follows, and

input the time in the numeric column.

3. Mode Usage Methods

(3) Binning Pixels
* Available in both Precision and Increment.

After 4 pixels (2x2) undergo analog processing as 1 pixel, they are
digitized.
From this processing, resolution of the entire image will decline but
sensitivity will increase.

Setting method Select by clicking the box for Binning Pixels.

(4) Visible Frame Grab.
Cannot be used.

(5) Lens Type
The type of lens installed in the LAS-1000 or LAS-1000C is displayed.
When the LAS-1000 or LAS-1000C is used, set the Lens Type using the
following pulldown menu.
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(6) Iris
* Available in both Precision and Repetition.
For the LAS-1000plus system, the lens aperture value is automatically
selected in accordance with the IDXII setting.
Select either (right) or (left) with upper handle.
Confirm the iris of the lens that has been installed in the LAS-1000 or
LAS-1000C and set the same value.

Note :
The iris of the lens installed in the LAS-1000 will not be automatically
controlled in accordance with the value set here.
For a high-sensitivity lens :

Select 0.85, 1, 1.4, 2, 2.8, 4, 5.6, 8, or 11.
For a standard lens :

Select 1.4, 2, 2.8, 4, 5.6, 8, 11, or 16.
For other lenses :

The iris setting cannot be made.

Setting method Set using the pulldown menu, as follows.

Note :
The position of the specimen inside the LAS-1000 or LAS-1000C dark box
will not be automatically controlled in accordance with the position set here.

(7) Position
* Available in both Precision and Repetition.

Selects the position (from step 1 to step 7) of the specimen (tray) set
inside the LAS-1000plus dark box.
When the LAS-1000 or LAS-1000C is used, set the position using the
following pulldown.

Setting method Set using the pulldown menu, as follows. :
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(8) Dark-Frame Subtraction
In Increment, because Dark-Frame Subtraction must be done at each
set exposure time, the Dark-Frame Subtraction setting cannot be turned
OFF.

(9) Spotting
* The sequential exposure mode (Increment), exposure will be automati-
cally shut off pixel defects, and thus the Disabled (OFF) mode cannot be
used.
Sets disabled.

(10) Optical Unevenness Correction (Flat-Frame Correction)
Flat-Frame Correction processing cannot be done in Increment.

(11) Lens Distorsion Correction.
Cannot be used.

(12) Invert Pixels
Supposing that film density will be measured, conducts inversion
processing on the intensity of each pixel of image data.

Setting method Click the box for Invert Pixels to select.

Note :
It is good to conduct Invert Pixels processing at time of image storage.

(13) Image Data Offset
Cannot be used.

(14) File Name

(15) Comment
Set the file name and comment for the exposed image.

Setting method Input from the keyboard into the boxes for File Name

and Comment.

(Exposure is possible even if nothing is input.)
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Click the Start button,  , to start exposure.

A window like the following will be displayed and images added at each set
exposure time will be displayed.
When the targeted image has been obtained while confirming the image,
click the stop button,  , and quit exposure.

(1)
(2)

(1)

(2)

3. Mode Usage Methods

3.4.2 Exposure Startup

As shown below, the window will be displayed divided in sixteen, and the
newest 16 images, including the last one obtained, will be displayed in a
time series.

* The indicators below the images, except for the time elapsed ones, are the
same as in Precision.

Exposure time elapsed

Total time elapsed

No

GOOD
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After saving the image, click the  button to return to the Repetition
exposure condition setting window.

3. Mode Usage Methods

No

GOOD
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User's Tips:
An image file name is added with ".img" as the extension. When an image
file is created, a relevant image information file (".inf") will also be created
at the same time.
If an ".inf" file is deleted from the hard disk, a problem will result in its relevant
".img" file.

3. Mode Usage Methods

3.4.3 Saving Images Click the mouse to select the image to be saved. (It will be displayed within
a red frame).
Click  in the image display window.
The following dialog will be displayed.

If you click the  button without saving the image, the following dialog
will be displayed.

3.4.4 Printing Images

* Available in both Precision and Increment.

Printing images is not possible.
Save the images and then output using external software.
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Part

6
Flat-Frame Maker Operation
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1. Introduction

2. Operation Procedures

1. Introduction / 2. Operational Procedure

Flat-Frame Maker is the software to create original data for optical uneven-
ness correction of the Image Reader LAS-1000 Lite.
The reading noise for Increment/Repetition exposures using the Image
Reader LAS-1000 Pro with LAS-1000C or LAS-1000 is created with this
Flat-Frame Maker.

The operation procedures are as follows.

1 Adjust focus using the Image Reader. Adjust focus on the
tray surface beforehand using the tray for incident light.

2 Set the tray in the dark box as follows.
For fluorescence / Digitize : EPI

Put the calibration plate on the sample tray and set it to the dark
box.

* Set the sample tray with the rough surface facing up (the seal surface
facing down)

Calibration plate

For Digitize : DIA
Set the transparent tray in the dark box placing nothing on it.

User's Tip :
Proper correction will not be possible unless preset focusing is correct.

* In the Option mode, select an appropriate method for the type of light
source used.
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<IDX-II Status>
CCD Status
CCD Temp
Selected Method
Position

2. Operational Procedure

3 Start up the Flat-Frame Maker and set each item.
After the dialog prompting focusing has been displayed, the initial screen
like that shown below will be displayed.

Software will automatically check these

items.

<Progress>
1 2 3 4 5 6 7

Fluorescence : X X X X X X X
Digitize (EPI) : X X X X X X X
Digitize (DIA) : X X X X X X X

<Exposure Method>
Auto(Navigator)
When Auto is selected, exposure will be done with the pre-set
exposure time.
Any combination can be exposed first but order on and after the
second will be fixed.  For example, if tray position 3 in the fluores-
cence mode is exposed, order of exposure on and after the second
will be as follows.
Fluorescence mode 4->7, then Digitize (EPI)1->7, Digitize (DIA)1-
>7, and at last, Fluorescence mode 1->2.

Note :
 When Auto is selected, Binning cannot be selected.

The X mark will change to the O

mark for the combination (Mode +

Tray position) whose

exposure is completed.
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Creation of flat frame for the Option mode is available only in the Manual
mode.
Select the light source, filter and use or no-use of bining, and then set the
expowure coonditions for use.

4 After settings have been completed, click the 
button.
Exposure will start.

5 After the operation has been terminated, click the
 button to quit the software.

Manual
Exposure is possible with desired exposure time.  When Manual is
selected, Binning can be selected.
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Part

7
Troubleshooting
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1. Error Codes Displayed on
the Analyzing Unit and
Countermeasures

1. Error Codes Displayed on the Analyzing Unit and Countermeasures

Take the following procedures when an error occurs in the system, causing
to display its relative error code in the analyzing unit.

1 Take note of the error code message.

2 Turn OFF the power to the camera controller and the analyzing unit and
turn it ON again after approx. 10 sec.

3 When the error recurs, fill in the necessary items and the error code in
the TROUBLE SHEET attached to the end of this document, and then
contact your sales dealer.
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2. Troubles and Countermeasures

2.1 Camera Head Trouble
Cause Analysis

2. Troubles and Countermeasures

If the error still remains uncorrected even after the following countermea-
sures have been taken, fill in the necessary items and the error code in the
TROUBLE SHEET attached to the end of this document, and contact your
sales dealer.

Phenomenon

Camera head LED (POWER)
does not light.

Camera head generates strange
noise.

Analyzing unit CCD temperature
indication does not change to
[READY] or does not come
closer to the set temperature
after a sufficient time — about
15 min. — has elapsed since
the start of cooling.

Cause

Signal cable installation failure

Camera head failure

1 Surrounding temperature too high

2 CCD set temperature too low

3 Camera head DC power cable
installation failure

4 Camera head's exhaust port is
covered.

Countermeasure

Correctly connect the signal
cable.

Contact your sales dealer.

Set surrounding temperature
below 28Åé.

Set CCD temperature to higher (only
for Image Reader Pro).

Correctly connect the camera
head DC power cable.

Make sure that nothing covers
the camera head exhaust port.
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2.2 Camera Controller and Reading Software
Trouble Cause Analysis

Phenomenon

Controller generates strange
odor.

Controller LED does not light.
(At time of startup diagnosis, all
LEDs light.)

Image is not displayed on
monitor in Focusing mode.

The image reading software does
not recognize the LAS-1000plus
system. (Error is displayed.)

Even when the set exposure
time has elapsed, reading
operation does not end.

After exposure, no image is
displayed on monitor.

Cause

Camera controller failure.

1 Supply voltage dropped

2 AC power cable installation failure

1 EIA/CCIR changeover SW setting
failure

2 Video cable installation failure

3 Brightness of the image reading
software is low.

4 Video Overlay Board failure or
setting failure. (for Windows)

1 SCSI ID setting failure

2 SCSI cable installation failure

3 IDX communication cable
connection failure

4 SCSI board connection failure
(only for Windows)

1 Camera controller power has been
turned OFF halfway exposure.

1 Exposure time is  short.

2 Focus is not correctly adjusted.

Countermeasure

Turn OFF the controller's
power immediately and
contact your sales dealer.

Check the supply voltage.

Correctly connect the AC
power cable.

Correctly set the EIA/CCIR
changeover SW.

Correctly connect the video
cable.

Increase Brightness of the
image reading software.

See the Operation Manual of
the Video Overlay Board.

Set the SCSI ID to [4] and make
sure not to specify the same
SCSI ID for  different devices.

Correctly connect the SCSI
cable.

Confirm the connection of the
IDX communication cable.

Connect the LAS-1000 with
asynchronous mode.

Reboot the camera controller.

Make the exposure time longer.

Adjust focus.
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Phenomenon

It takes longer time than usual
to start up.

Software does not proceed to
the Exposure mode.

Exposure cannot be done even
though the start button has been
pressed.

The Image Reader does not
start up.

Cause

More than one week has elapsed
from the previous acquisition of
corrected data. (only for Lite version)

Surrounding temperature is too high.

IDX door is open.

Power of the camera controller had
once been turned off.

Correction file has been lost.
Or Correction file is not ready.

IDX door is open.

Tray is not inserted to the depth.

Function setting handle of IDX is not
set to the correct position.

The Meteor II driver is not installed.
(for Windows)

Countermeasure

Data is being acquired again
on the camera side.  It will
take about 3 minutes.

Set the surrounding
temperature below 28ºC.

Close the door.

Restart the reading software.

Check the inside of the Flat-
Frame folder and the Dark-
Frame folder.

Close the door.

Insert the tray to the depth.

Align the handle properly with
the mark in IDX.

Install the Meteor II driver.

2. Troubles and Countermeasures
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Cause

Foreign object is present in the
locking section or door sensor.

Hinge creaks.

1 Dark box DC power cable
installation failure

2 Dark box internal connector
disconnected.

3 (When the door is opened)
Software is not in the Focusing
mode.

4 Foreign object is present in the
door sensor.

Countermeasure

Remove foreign object.

Apply grease to the hinge.

Correctly connect the dark
box DC power cable.

Correctly connect the dark
box internal connector.

Enter in the Focusing mode
on the computer.

Remove foreign object.

Phenomenon

Dark box door cannot be
opened/closed.
Dark box cannot be locked.

Abnormal sound is audible when
dark box is opened/closed.

Illumination does not light.

2. Troubles and Countermeasures

2.3 Dark Box Trouble Cause Analysis
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2.4 Image Trouble Cause Analysis

Phenomenon

It looks as if there is mist on the
image.

Read data is abnormal.

There is fogging on the image.

Image does not appear
appropriately.

Cause

Moisture condensation in the optical
system.

1 Exposure dose is high.

2 Focus is not correctly adjusted.

3 Insufficient cleaning of the tray.

4 Lens filter is dirty.

Exposure to direct sunlight.

1 Size of the target to be exposed
and the exposure angle do not
match.

2 IDX function selection and the target
to be exposed do not match.

3 LED illumination does not light at
time of fluorescent measurement.

4 The aperture is stopped or
released too much.

5 Underexposure.

6 Exposure dose is high.

Countermeasure

Quit the reading software normally,
wait as it is and see Part 2,2
"Specifications" to make the
operation environment meet the
specifications.

Make the exposure time
shorter.

Correctly adjust focus.

Clean the tray thoroughly.

See Part 8 " Regular
Maintenance."

Avoid direct sunlight.

Set the angle so that the size
of the target shall be within
80% of the angle.

Match the function and the
target.

Turn ON the LED.

Readjust the aperture or
change the exposure time.

(Change Auto to Manual if
not, and) make the exposure
time Auto.

Make the exposure time
shorter.
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LAS-1000 not ready. Please wait.

LAS-1000 error: Exposure failed.
Key: 4H  Code: 8100H

LAS-1000 error: Shutter error.
Turn off Camera Controller and restart LAS-
1000.
Key: 4H  Code: 830xH
LAS-1000 error: Shutter error.
Key: 4H  Code: 830x

LAS-1000 error: Shutter error.
Key: 4H  Code: 830xH

LAS-1000 error: Shutter error.
Key: 4H  Code: 830xH

LAS-1000 error: Camera head cooling system
error.
Turn off Camera Controller and restart LAS-
1000.
Key: 4H  Code: 8x00H

LAS-1000 error: Camera unit communication
error.
Turn off Camera Controller.
Check connections between Camera Head and
Camera Controller.
Key: 4H  Code: 8700H

LAS-1000 error: DRAM access error.
Turn off Camera Controller and restart LAS-
1000.
Key: 4H  Code: 8800H

Diagnosis during startup.

Abnormal exposure termination
error.
Error when the CCD cut-in has
not occurred within 4 seconds
after exposure termination.

Shutter error.
Error such as the one of the
mechanical shutter resettting
which is done when an
abnormal status prior to start of
exposure is detected during
startup diagnosis.

Shutter error.
When the shutter is abnormal
before the start trigger of the on
and after the second exposure
in Increment mode, etc.

Shutter error.
Error in the Focusing mode.

Camera fan status error.
Camera temperature status error.

Camera head communication
error.

DRAM access error.
Error when the DRAM writing/
reading has not terminated
normally during startup
diagnosys.

1

2

3

4

5

6

7

8

3. Error Display
Contents and
Countermeasures

3. Error Display Contents and Countermeasures

Error message Content CountermeasureNO

Explained here are the contents of the error messages that can appear
when using this software and related countermeasures.

* If trouble recurs even after countermeasures have been taken, please
contact your sales dealer.

Wait until READY
is displayed.

Wait until READY
is displayed.

Restart the
system.

Restart the
system.

Restart the
system.

Restart the
system.

Turn the power
OFF and check
cable
connections.

Restart the
system.
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LAS-1000 error: Camera Controller error.
Turn off Camera Controller and restart LAS-
1000.
Key: 4H  Code: 8900H

LAS-1000 error: Invalid request error.
Key: 5H  Code: xxxxH

LAS-1000 error: Aborted command error.
Key: BH Code: xxxxH

Camera Controller.
Error was detected in the Fan
status and Heat Thing
temperature in the Camera
Controller.

Error was detected in the
operation code detection of the
unsupported command
operation code, etc.

Message error was detected.
Invalid message was detected.

9

10

11

Error message Content CountermeasureNO

IDX-II setup error. Check tray and panel
condition.

Door of IDX-II is open. Please close it.

CCD temperature has not reached set level yet.

The IDX-II setting is "Option." Continue?

Set exposure time to between 2 and 3600 sec.
or 1 and 60 min.

Door of IDX-II possibly open during exposure.

Cannot find Flat-Frame correction on distortion
correction file for the current IDX-II's panel
setting.

When the Start button has been
selected (exposure has been
started) in the incorrect IDX-II
setup status.

When the Start button has been
selected (exposure has been
started) with the IDX-II door open.

When the Start button has been
selected (exposure has been
started) with the WAIT status of
the CCD cooling.

When the Start button has been
selected (exposure has been
started) with the IDX-II setting
"Option."

When the Start button has been
selected (exposure has been
started) with incorrect Exposure
Time set with Manual.

Displayed immediately after the
image had been displayed after
the exposure temination if the
door of IDX-II had been opened
during exposure.

Displayed if the Start button has
been selected when the
shading correction and
distortion correction data could
have not been found at the time
of start of exposure.

1

2

3

4

5

6

7

Error message Content CountermeasureNO

Error Messages Appearing at Start/Termination of Exposure

3. Error Display Contents and Countermeasures

Restart the
system.

Click OK to
continue.

Click OK to
continue.

Check panel
settings, whether
tray is present or
not and that tray
is firmly set.

Close the door.

Wait until READY
is displayed.

If optional
selection is OK,
continue.

Correctly set the
exposure time.

Recorded image
data is not
effective.

Check a Flat-
Frame file that
matches the 2
SHD_URF20L_Op85.
dat and
DST_URF20L.dat
files.
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LAS-1000plus is not connected.
(at the time of Software startup).

Camera Controller is under
startup operation (at the time of
Software startup).

Turn the power
OFF and check
cable
connections.

Wait until
READY is
displayed.

LAS-1000plus not connected to SCSI port.

LAS-1000plus not ready. Please wait.

1

2

Error message Content CountermeasureNO

Software Startup/Quit Operation, etc.

3. Error Display Contents and Countermeasures
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Part

8
Regular Maintenance
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* Intelligent dark box and
camera controller
maintenance

* Sample tray maintenance

* Camera head, lens and
optical filter maintenance

Part 8. Regular Maintenance

Use a soft dry cloth to clean dirt on the exterior. To clean dirt that is hard to
remove, use a soft cloth slightly damped with neutral detergent and then
clean with a new dry cloth.
To clean the dark box interior, use a non-fluorescent cleanser for biochemi-
cal use. If a neutral cleanser for household use is used, the cleanser
residue could produce fluorescence at time of fluorescent image recording.
Do not use organic solvent because it damages the paint.

After using the sample tray, wash it in water using soft sponge slightly
damped with neutral detergent and the like.  Do not use a cleaner such as
nylon scrubbing brush which is likely to damage the tray surface.  After
cleaning, leave the tray for natural drying.

Use only a soft dry cloth to clean the exterior.
To prevent image quality from deteriorating, observe all cautions concern-
ing optical parts.

(1) Never touch the optical parts (camera lens surface, camera head
optical window, fluorescent filter, glass material of the LED unit) with
your bare hands.

(2) Use an air blower available on the market to blow off all dirt, dust, etc. If
you mistakenly touch the lens glass or the like with your bare hands,
use lens cleaning paper, that is available on the market, slightly damp-
ened with lens cleaner solution also available on the market to lightly
and gently wipe off the surfaces touched. If touched surfaces are not
uncleaned, the sebum left on them will degenerate and become not
only difficult to remove but a cause of mold as well.

(3) Do not unnecessarily loosen or securely tighten fixing screws or tie
rings, or optical part performance will deteriorate severely.

(4) Remove the protective caps attached to the camera head and camera
lens when unit installation work is completed, as a rule. Before remov-
ing units, make sure to first attach the caps. In keeping, customers
should store these caps carefully.
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Part

9
After-Sale Service
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1. Warranty (1) The warranty period will expire 1 year from the date the system was
delivered.

(2) Fujifilm will make repairs free of charge for failure resulting during the
warranty period, provided that normal usage conditions and the  instruc-
tions given in this manual, etc., are followed.

(3) Repair of the following failures will be charged for even if the warranty
period has not yet expired.

i. Troubles caused by incorrect usage and/or by any products other
than those authorized by Fuji and/or troubles caused by other
equipment.

ii. Troubles and/or damages due to moving, transport and/or falling.

2. Repairs (1) Before asking for repairs, see Part 7 “Troubleshooting” of this manual.
(2) If failure results, fill out the TROUBLE FAX SHEET attached hereto and

contact your sales dealer.
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